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NEW QUESTION 1
You have a workbook query that gets a table from an Excel workbook. The table contains a column1. In the query, you configure Column1 to use a Data Type of
Whole Number.
You refresh the data and find several errors in Column1. You discover that new entries in the table contain nonnumeric characters.
You need to ensure that when the data is imported, any fields that contain nonnumeric values are set 1. What should you do from Query Editor?

A. Select the table and click Keep Errors.
B. Select the column and click Replace Values...
C. Select the column and click Remove Errors.
D. Select the column and click Replace Errors...

Answer: D

NEW QUESTION 2
You need to create a PivotChart that has a filter as shown in the following exhibit.

What should you do first?

A. From the model, create a measure.
B. From Query Editor, create a function.
C. From Query Editor, create a parameter.
D. From the model, create a hierarchy.

Answer: A

Explanation: 
References:
https://support.office.com/en-us/article/measures-in-power-pivot-86484821-a324-4da3-803b-82fd2e5033f4

NEW QUESTION 3
You import the data from two next files into a PowerPivot model to create two tables named Customers and Invoices. Each table contains a column named
CustomerID.
When you attempt to create a relationship between the Customers table and the Invoices table by using the CustomerID column from each table, the relationship
cannot be created due to duplicate CustomerID values.
You need to ensure that you can create the relationship. What should you do?

A. Add an index column to the Customers query
B. Add an index column to the Invoices query
C. Group the Customers query by CustomerID
D. Sort the Invoices query by CustomerID, and then add a Fill Down step

Answer: C

NEW QUESTION 4
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have the following data.

You need to retrieve a list of the unique ProductName entries.
Solution: Open the Advanced Filter dialog box, select Filter the list, in-place, and then select Unique records only.
Does this meet the goal?

Guaranteed success with Our exam guides visit - https://www.certshared.com



Certshared now are offering 100% pass ensure 70-779 dumps!
https://www.certshared.com/exam/70-779/ (117 Q&As)

A. Yes
B. No

Answer: A

NEW QUESTION 5
Note: This question is part of a series of questions that use the same scenario, For your convenience is repeated in each question. Each question presents a
different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The tables are loaded to the data model, but the data is not
loaded to any worksheets. The data model is shown in the Data Model exhibit.
Your company has 100 product subcategories and more than 10,000 products. End of repeated scenario.
You need to create a measure named [Sales Monthly RT] that calculates a running total of [Sales] for each date within a month as shown in the following exhibit.

How should you complete the DAX formula? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
SUM [Sales], DATESMTD
The following sample formula creates a measure that calculates the 'Month To Date Total' for the Internet sales.
To see how this works, create a PivotTable and add the fields, CalendarYear, MonthNumberOfYear and
DayNumberOfMonth, to the Row Labels
area of the PivotTable. Then add a measure, namedMonth To Date
Total, using the formula defined in the code section, to the Values
area of the PivotTable.
=CALCULATE(SUM(InternetSales_USD[SalesAmount_USD]), DATESMTD(DateTime[DateKey])) https://msdn.microsoft.com/en-us/query-bi/dax/datesmtd-
function-dax

NEW QUESTION 6
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it As a result, these questions will not appear in the review screen.
You have an Excel workbook that contains a table named Table1. A sample of the data in Table1 is shown in the following table.

You need to create a PivotTable in PowerPivot as shown in the exhibit.
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Solution: You create a hierarchy named Products that contains ProductCategory,
Solution: You create a measure named Products the uses the DataTable DAX Function. You add a PivotTable. You drag products to the Rows field. You drag
Price to the Values field.
Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 7
You have the following table.

You plan to use [Month Name] as the axis in a PivotChart.
You need to ensure that whenever [Month Name] is used in a chart, the months are displayed chronologically be default.
What should you do?

A. Sort the [Month Name] column by [Month Name].
B. Change the Data Type of [Month Name] to Date.
C. Sort the [Month Name] column by [Month Name].
D. Add a calculated column named [ID] that use the [Month Name] & [Month Number] DAX formula

Answer: D

Explanation: 
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References:
https://gasperkamensek.wordpress.com/2013/04/16/sorting-months-chronologically-and-not-alphabetically-in-a-

NEW QUESTION 8
You have a measure that is used by a KPI.
You need to display the output of the measure in a cell in your workbook. Which Excel function should you use?

A. CUBEVALUE
B. VLOOKUP
C. CUBESET
D. LOOKUP

Answer: A

Explanation: 
https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-84a8f00dcbe0 https://powerpivotpro.com/2010/06/using-excel-cube-
functions-with-powerpivot/

NEW QUESTION 9
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The tables are loaded to the data model, but the data is not
loaded to any worksheet. The data model is shown in the Data Model exhibit. (Click the Exhibit button.)
Your company has 100 product subcategories and more than 10,000 products.

End of repeated scenario.
You need to create a measure named [Sales Monthly RT] that calculates a running total of [Sales] for each date within a month as shown in the following exhibit.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
SUM([Sales],DATESMTD(DimDate[Date])) CALCULATE(SUM([Sales],DATESMTD(DimDate[Date])))

NEW QUESTION 10
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have a Power Pivot model that contains the following tables.?

There is a relationship between Products and ProductCategory.
You need to create a hierarchy in Products that contains ProductCategoryName and ProductName. Solution: You create a measure that uses the
USERELATIONSHIP DAX function.
Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 10
From a workbook query, you import a table that has the following data.

You need to configure the table to appear as shown in the following table.

What should you do?

A. From the Format menu, click Trim.
B. From the Format menu, click Clean.
C. From the Split Column menu, click By Delimiter.
D. From the Extract menu, click Last Characters.

Answer: A

NEW QUESTION 15
You have a workbook query that loads data from a table named Products. Products contains a column named IntemalPrice that has a Data Type of Decimal.
From Query Editor you create a custom column named ResellerPrice that uses a formula to multiply InternalPrice by 1.2, and then you remove the IntemalPrice
column.
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What will occur when you load the data to a worksheet?

A. All the columns except InternalPrice will load to the worksheet The values in ResellerPrice will be correct.
B. An error message will appear and all the data will fail to load.
C. An error message will appear and all the columns except InternalPnce and ResellerPrice will load to the worksheet.
D. All the columns except InternalPrice will load to the workshee
E. The values in ResellerPrice will be null.

Answer: D

NEW QUESTION 18
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario.
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.)
Data Sample exhibit:

The data model is shown in the Data Model exhibit. (Click the Exhibit button.)

The tables in the model contain the following data:
 DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or

revenue are recorded for that day. Total Hours and Total Revenue column.
 Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always

Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.
 RepairTypes has a list of all the repair types
 Dates has a list of dates from 2015 to 2018

End of repeated scenario.
To the Dates table, you need to add a calculated column named Months Ago. Months Ago must display the number of calendar months before the current month.
For example, if the current date is July 10, 2017, the Value of Months Ago will be 0 for all the dates in July 2017, 1 for all the dates in June 2017, and 2 for all the
dates in May 2017.
How should you complete the DAX formula? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A
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Explanation: 
Box 1: MONTH
Box 2: TODAY
References:
https://msdn.microsoft.com/en-us/library/ee634914.aspx https://msdn.microsoft.com/en-us/library/ee634567.aspx https://msdn.microsoft.com/en-
us/library/ee634554.aspx

NEW QUESTION 22
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it As a result, these questions will not appear in the review screen.
You have an Excel workbook that contains a table named Table1. A sample of the data in Table1 is shown in the following table.

You need to create a PivotTable in PowerPivot as shown in the exhibit.

Solution: You create a hierarchy named Products that contains ProductCategory, ProductSubCategory, and ProductName. You add a PivotTable. You drag
Products to the Rows field. You drag Price to the Values field.
Does this meet the goal?

A. Yes
B. No

Answer: A

Explanation: 
Hierarchy Products that contains ProductCategory, ProductSubCategory, and ProductName
https://www.tutorialspoint.com/excel_power_pivot/excel_power_pivot_hierarchies.htm

NEW QUESTION 23
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
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You have a Power Pivot model that contains the following tables.

There is a relationship between Products and ProductCategory.
You need to create a hierarchy in Products that contains ProductCategoryName and ProductName. Solution: You create a calculated column that uses the
RELATED DAX function
Does this meet the goal?

A. Yes
B. No

Answer: A

Explanation: 

References:
https://www.mssqltips.com/sqlservertip/2900/creating-hierarchies-in-powerpivot-for-excel/ https://msdn.microsoft.com/en-us/library/ee634202.aspx

NEW QUESTION 24
You have the following table named SalesOrder Detail in a model.

You need to calculate the sum of SalesTotal for all the rows that have a quantity greater than 1.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
CALCULATE(SUMX(‘SalesOrdersDetail’[SalesTotal]),‘SalesOrderDetail’[Quantity] > 1)

NEW QUESTION 27
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have two Microsoft SQL Server database servers named Production1 and Test1. Production1 contains the same tables as Test1, but only a subset of the
data.
You add Test1 as a data source, and you select 10 tables. You configure several transformations. You need to connect the model to the tables in Production1. The
solution must maintain the existing
transformations.
Solution: From Query Editor, you configure the Data source settings. Does this meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 28
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You have a PivotChart template named Template1. You add a PivotChart to a worksheet.
You need to apply the template to the PivotChart. What should you do?

A. On the Design tab, click Change Chart Type.
B. On the Format tab, click Format Selection.
C. Right-click the chart and then click PivotChart Options.
D. Right-click the chart and then click Format Chart Area.

Answer: A

Explanation: 
 Click the chart
 On the Charts tab, under Change Chart Type, click Other, and then under Templates, click the chart template that you created.

https://stackoverflow.com/questions/17386777/how-to-apply-a-saved-chart-template-to-an-existing-chart

NEW QUESTION 29
You have a Power Pivot data model that contains a table named DimProduct DimProduct has seven columns named ProductKey, ProductLabel, ProductName,
ProductDescription, ProductSubCategoryKey, Manufacturer, and Brand.
Only the members of the product team use all the data in the DimProduct table.
You need to simplify the model for other users by hiding all the columns except ProductName. What should you do?

A. Create a perspective that has only the ProductName field from DimProduct selected.
B. Select all the columns in DimProduct except ProductName, right-click the columns, and then click Hide from Client Tools.
C. Edit the Default Field Set for DimProduct and add ProductName to the Default Field.
D. Edit the Table Behavior settings for DimProduct and add ProductName to the Default Label.

Answer: B

Explanation: 
https://support.office.com/en-us/article/hide-columns-and-tables-in-power-pivot-ddf5b1f2-2ed2-4bdb-8f78-6f94

NEW QUESTION 33
You have the following tables in a data model.

You create a PivotTable to display SaleAmount by Month. A sample of the results are shown in the following table.

A. In the data model, modify the Sort By Column setting for Date[Month Year].
B. From PivotTable Fields, add Date[Year] to the Rows area.
C. In the data model, modify the Sort by Column setting for Sales[Date].
D. From PivotTable Fields, modify the Field Settings for DatelMonth Year].

Answer: C

NEW QUESTION 34
You have 20 workbook queries that load 20 CSV files to a local computer.
You plan to send the workbook and the 20 CSV files to several users. The users will store the files in various location.
You need to ensure that the users can change the path to the CSV files in the queries as quickly as possible. What should you do from Query Editor?

A. Merge all the querie
B. Edit the source of the first query.
C. Create a paramete
D. Modify the source of each query to use the parameter.
E. For each query, create a new query that uses a referenc
F. Modify the source of each new query.
G. Append all the querie
H. Edit the source of the first query.

Answer: B

Explanation: 
https://www.howtoexcel.org/power-query/how-to-parameterize-your-power-query/ 

NEW QUESTION 38
You have two queries named Client and Invoices. A sample of Client is shown in the following table.
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A sample of Invoices is shown in the following table.

You need to create a new table that has the following information.

Which join kind should you use?

A. Inner
B. Left Outer
C. Right Anti
D. Left Anti

Answer: B

Explanation: 
https://www.excelguru.ca/blog/2015/12/16/merge-tables-using-outer-joins-in-power-query/

NEW QUESTION 41
You have a data model that contains a table named SalesOrders has four columns named Orderld, SalesAmount, OrderDate, and Territory.
You plan to create a PivotChart that will display the percentage of SalesAmount for each Territory. You need to create a measure to calculate the percentage of
sales of each territory.
How should you complete the DAX formula? To answer, drag the appropriate value to the correct targets. Each value may be used once, more than once, or not at
all. You need to drag the split bar between panes or scroll to view content.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
SUM([SalesAmount) / ALL(SalesOrders) /(FILTER , ALL(SalesOrders))

NEW QUESTION 43
You have a table in Power Pivot model that is loaded from a Microsoft SQL Server database.
The source table has four columns named ID, Price, Quantity, and Total. Total is derived by multiplying Price and Quantity. ID is a unique row identifier.
You need to minimize the amount of memory used to load the mode. The solution must ensure that you can create visualizations based on Price, Quantity, and
Total.
What should you do?

A. Replace the Total column by using a measure.
B. Replace the Total column by using a calculated column.
C. From Query Editor, remove duplicate rows from the table.
D. Move the Total column to a lookup table.

Answer: A

Explanation: 

References:
https://support.office.com/en-us/article/create-a-memory-efficient-data-model-using-excel-and-the-power-pivot-

NEW QUESTION 47
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You have an Excel workbook that has the following two workbook queries:
* A query named Consultants that retrieves a table named Consultants_Contact from a Microsoft SQL Server database
* A query named Employees that retrieves a table named Employee_Contact from a Microsoft Azure SQL database
Both tables have the same columns.
You need to combine all the data from Consultants and Employees into one table. Which command should you use?

A. Transpose
B. Merge Queries
C. Combine Binaries
D. Append Queries

Answer: D

Explanation: 
Append is similar to UNION ALL in T-SQL.
Append Queries will NOT remove duplicates. You have to use Group By or Remove Duplicate Rows to get rid of duplicates.
Merge is similar to JOIN in T-SQL
http://radacad.com/append-vs-merge-in-power-bi-and-power-query

NEW QUESTION 52
You have a table named Sales that has three columns named OrderDate, OrderNumber, and SalesAmount. You need to create the PivotTable as shown in the
following table.

What should you use?

A. KPIs
B. sparklines
C. conditional formatting
D. banded rows

Answer: A

NEW QUESTION 55
......
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